
这是我第一次 ieee 论文排版的总结，可能对想给 ieee 投稿但经验不丰富的人有用，大虾就不要看了：） 
本文主要针对论文中的图像，图表等的处理，其它请参看 ieee 网站论文模板 
（http://www.ieee.org/organizations/pubs/transactions/stylesheets.htm）。 

使用范围：基本上是当你的论文被 ieee accept 之后，才会考虑到图片的具体要求。不过，在平时论文

写作中用这些方法也可以使图片的打印的效果更加清晰。 
附：ieee 文档模板，给 ieee 投稿时可以看看 ieee 对排版等其它格式的要求。 

一、图片图像要求 

1、分辨率（resolution） 

a) 艺术线条       line art（figures，table，charts，drawings） 600dpi（1 bit/sample） 
b) 照片及其它灰度图 photographs and other gray scale images   220dpi (8 bit/sample) 

2、尺寸（size） 

a) Line art, tables and graphics  3.5 inches(21 picas)  或者  7-1/16inches (43picas)   即一栏（column）或

者两栏的宽度。以上只是对图像宽度（width）的要求。 
b) 最大不能超过 8.5 x 11 inches 
c) 作者照片 最后打印的照片尺寸是 1 x 1.25 inches(6 x 7.5 picas)，如果作者的照片不出现在文章的最后，

请调整到标准尺寸 1 9/16 x 2 inches (9.5 picas x 12 picas)或者与之成比例。 

3、格式 

a) Accept format：TIFF，PS and EPS 
b) Line art：black & white bitmap and no grayscale. 
c) Photographics: grayscale 

4、命名 naming your grahics 

a) 全用小写字母，图中不能包含图片说明（caption），但是对于多个组成部分的图片需用（a），（b）（c）
等进行编号。图中的字体用 Times New Roman，并且图中字体的大小应统一 

b) 对于图形（figures），包括 line art（不包括 table），graphics，应该以下列方式命名：fig1.tif, fig2.eps, fig3.ps..., 
注意不要给图形起描述性的名字 

c) 作者照片的命名：使用作者姓的最后五个字母（没有五个的话就有几个写几个），如：zhao.tif, smith.tif, 
lee.eps  

d) 表格（table）：table1.tif, table2.eps, table3.ps 等等。表格转成图像时不能包含 table caption。表格不能有

竖框线。如下所示 
Table1: example 

hehe 800 140 180 190 160 190 200 200 

Dd 23 179 83 87 90 925 94 98s 

http://www.ieee.org/organizations/pubs/transactions/stylesheets.htm


Ee 10d 10d 145 1s5 1d5 1d2 12s 13s 

Ff 126 27 1128 129 3s0 31s 3s2 33 

e) 字体：如果图片中需要使用字体，建议使用 adobe type1 fonts：times new roman, Helvetica, Narrow, 
Courier, Symbol, Palatino, Avant Garde, Bookman, Zapf Chancery, Zapf Dingbats, New Century Schoolbook, 
字体大小：当最后打印出来的时候为 8 磅就可以了，自己按比例调节吧。 

二、合格图像生成步骤 

对于科技论文，大部分图像都是由 matlab 生成的，在这里主要介绍一下 matlab 图像和 word 中表格的

处理。 

1、matlab 图像的处理 

按照“一”中所列出的要求，对于 line art 的分辨率要求是 600dpi，导出格式为 tiff 或 eps 的图像。 
作为例子，采用一正弦波 y＝sin（x），图像如下： 
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Step1:在 matlab 图像窗口中，打开 file－>Exprot Setup; 



 
出现导出文件设置对话框： 

 
这里有 4 个属性页，分别是 size，rendering，fonts，lines。 
图像的大小就在 size 属性页中设置，对于单栏的图像是 3.5 inches 宽，在相应的位置修改即可，注意

长宽的比例。 
Resolution 分辨率是在 rendering 里边设置，按要求设置成 600 dpi，color space 设置成 black and white，

因为是单色图，本属性页其它的选项基本上可以不用修改，如果真的需要改，可参看 matlab 帮助。 



 
Fonts 在 fonts 属性页中，字体改为 times new roman，大小为 8 磅（points） 

 
Line 属性页是对图形中线条的修改，这个可以根据自己的喜好进行调整。 



 
改完之后，可以直接点 Export Setup 对话框中的 export 按钮进行存储，或者在图形窗口的 file->save,

出现存储对话框，以下就没有什么好说的了：） 

 
呵呵，其实还没完，当你把这张图用 photoshop 打开的时候，会发现它还是 rgb 色的 



 
很好办，把它改成黑白 2 色的 bitmap 就是了，方法：Image->Grayscale，Image->Bitmap，就 OK 了，

生成的文件大小在几百 k。（我不是很懂 photoshop，如果有更好的方法请大虾赐教），注意，如果存为 tiff
格式的时候，一定不要压缩图像，如上右图所示。 
 

2、表格的转换 

在 ieee 的 preparation of papers for ieee transactions and journals 上介绍了一种方法：在 word 里边把表格

放大致全屏，然后 word 全屏显示（视图->全屏显示），然后 print screen，粘贴到 Photoshop 图像编辑软件

中进行处理，但是打印出来看结果并不能让人满意。 
以 table1 示例，可以这样处理： 
1、将该表格粘贴到一个单独的 word 文档里边，然后保存为一个文件 

 



2、打开 visio 2003（别的版本应该也可以），新建绘图，单击 插入->对象，打开插入对象对话框，  

 

 
选择“根据文件创建”，单击“浏览按钮”，找到我们刚才创建的 word 文档 



 
这次就可以在 visio 里边看到表格了 

 
调整一下对象选择框的大小，完成之后，点 file－>save as，在保存类型中选择“tag 图形文件格式”，点击

save 按钮。 

 



出现如下对话框，进行如下设置： 
 数据压缩 无 
 颜色格式 两级 
 分辨率 600*600, 
 大小填上你需要的大小就可以了。 

 

Ok，大功告成了，如果需要，可以再用 shtoshop 等软件稍微处理一下，打印出来看看效果：） 
 

资源 

ieee 有一个在线的图片测试工具，图片生成之后可以测试一下，最后结果包含一些解决办法供参考 
http://graphicsqc.ieee.org/
tools for authors 
http://www.ieee.org/portal/site/mainsite/menuitem.818c0c39e85ef176fb2275875bac26c8/index.jsp?&pName=cor
p_level1&path=pubs/transactions&file=information.xml&xsl=generic.xsl
参考模板： 
http://www.ieee.org/organizations/pubs/transactions/stylesheets.htm

后记 

如果有什么意见或者建议，请发信到 zdy_hit@163.com，共同学习和进步，并把这份文档完善。 
也特别谢谢我亲爱的老婆 han，没有她的耐心可能就没有这份文档了。 

http://graphicsqc.ieee.org/
http://www.ieee.org/portal/site/mainsite/menuitem.818c0c39e85ef176fb2275875bac26c8/index.jsp?&pName=corp_level1&path=pubs/transactions&file=information.xml&xsl=generic.xsl
http://www.ieee.org/portal/site/mainsite/menuitem.818c0c39e85ef176fb2275875bac26c8/index.jsp?&pName=corp_level1&path=pubs/transactions&file=information.xml&xsl=generic.xsl
http://www.ieee.org/organizations/pubs/transactions/stylesheets.htm
mailto:zdy_hit@163.com
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Abstract—These instructions give you guidelines for preparing 

papers for IEEE TRANSACTIONS and JOURNALS. Use this 
document as a template if you are using Microsoft Word 6.0 or 
later. Otherwise, use this document as an instruction set. The 
electronic file of your paper will be formatted further at IEEE. 
Define all symbols used in the abstract. Do not cite references in 
the abstract. Do not delete the blank line immediately above the 
abstract; it sets the footnote at the bottom of this column. 
 

Index Terms—About four key words or phrases in 
alphabetical order, separated by commas. For a list of suggested 
keywords, send a blank e-mail to keywords@ieee.org or visit the 
IEEE web site at 
http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.tx
t 
 

I. INTRODUCTION 
HIS document is a template for Microsoft Word versions 
6.0 or later. If you are reading a paper version of this 

document, please download the electronic file, TRANS-
JOUR.DOC, from 
http://www.ieee.org/organizations/pubs/transactions/stylesheet
s.htm so you can use it to prepare your manuscript. If you 
would prefer to use LATEX, download IEEE’s LATEX style 
and sample files from the same Web page. Use these LATEX 
files for formatting, but please follow the instructions in 
TRANS-JOUR.DOC or TRANS-JOUR.PDF. 

If your paper is intended for a conference, please contact 
your conference editor concerning acceptable word processor 
formats for your particular conference.  

 
Manuscript received October 9, 2001. (Write the date on which you 

submitted your paper for review.) This work was supported in part by the U.S. 
Department of Commerce under Grant BS123456 (sponsor and financial 
support acknowledgment goes here). Paper titles should be written in 
uppercase and lowercase letters, not all uppercase. Avoid writing long 
formulas with subscripts in the title; short formulas that identify the elements 
are fine (e.g., "Nd–Fe–B"). Do not write "(Invited)" in the title. Full names of 
authors are preferred in the author field, but are not required. Put a space 
between authors' initials.  

F. A. Author is with the National Institute of Standards and Technology, 
Boulder, CO 80305 USA (corresponding author to provide phone: 303-555-
5555; fax: 303-555-5555; e-mail: author@ boulder.nist.gov).  

S. B. Author, Jr., was with Rice University, Houston, TX 77005 USA. He 
is now with the Department of Physics, Colorado State University, Fort 
Collins, CO 80523 USA (e-mail: author@lamar. colostate.edu). 

T. C. Author is with the Electrical Engineering Department, University of 
Colorado, Boulder, CO 80309 USA, on leave from the National Research 
Institute for Metals, Tsukuba, Japan (e-mail: author@nrim.go.jp). 

When you open TRANS-JOUR.DOC, select “Page Layout” 
from the “View” menu in the menu bar (View | Page Layout), 
which allows you to see the footnotes. Then type over sections 
of TRANS-JOUR.DOC or cut and paste from another 
document and then use markup styles. The pull-down style 
menu is at the left of the Formatting Toolbar at the top of your 
Word window (for example, the style at this point in the 
document is “Text”). Highlight a section that you want to 
designate with a certain style, then select the appropriate name 
on the style menu. The style will adjust your fonts and line 
spacing. Do not change the font sizes or line spacing to 
squeeze more text into a limited number of pages. Use 
italics for emphasis; do not underline.  

To insert images in Word, position the cursor at the 
insertion point and either use Insert | Picture | From File or 
copy the image to the Windows clipboard and then Edit | Paste 
Special | Picture (with “Float over text” unchecked).  

IEEE will do the final formatting of your paper. If your 
paper is intended for a conference, please observe the 
conference page limits.  

 

II. PROCEDURE FOR PAPER SUBMISSION 

A. Review Stage 
Please check with your editor on whether to submit your 

manuscript by hard copy or electronically for review. If hard 
copy, submit photocopies such that only one column appears 
per page. This will give your referees plenty of room to write 
comments. Send the number of copies specified by your editor 
(typically four). If submitted electronically, find out if your 
editor prefers submissions on disk or as e-mail attachments. 

If you want to submit your file with one column 
electronically, please do the following: 

 --First, click on the View menu and choose Print Layout. 
 --Second, place your cursor in the first paragraph. Go to 

the Format menu, choose Columns, choose one column 
Layout, and choose “apply to whole document” from the 
dropdown menu. 

 --Third, click and drag the right margin bar to just over 4 
inches in width. 
The graphics will stay in the “second” column, but you can 
drag them to the first column. Make the graphic wider to push 
out any text that may try to fill in next to the graphic. 

Preparation of Papers for IEEE TRANSACTIONS 
and JOURNALS (March 2004) 

First A. Author, Second B. Author, Jr., and Third C. Author, Member, IEEE 

T
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B. Final Stage 
When you submit your final version, after your paper has 

been accepted, print it in two-column format, including 
figures and tables. Send three prints of the paper; two will go 
to IEEE and one will be retained by the Editor-in-Chief or 
conference publications chair.  

You must also send your final manuscript on a disk, which 
IEEE will use to prepare your paper for publication. Write the 
authors’ names on the disk label. If you are using a 
Macintosh, please save your file on a PC formatted disk, if 
possible. You may use Zip or CD-ROM disks for large files, 
or compress files using Compress, Pkzip, Stuffit, or Gzip.  

Also send a sheet of paper with complete contact 
information for all authors. Include full mailing addresses, 
telephone numbers, fax numbers, and e-mail addresses. This 
information will be used to send each author a complimentary 
copy of the journal in which the paper appears. In addition, 
designate one author as the “corresponding author.” This is 
the author to whom proofs of the paper will be sent. Proofs are 
sent to the corresponding author only. 

C. Figures 
All tables and figures will be processed as images. 

However, IEEE cannot extract the tables and figures 
embedded in your document. (The figures and tables you 
insert in your document are only to help you gauge the size of 
your paper, for the convenience of the referees, and to make it 
easy for you to distribute preprints.) Therefore, submit, on 
separate sheets of paper, enlarged versions of the tables 
and figures that appear in your document. These are the 
images IEEE will scan and publish with your paper.  

D. Electronic Image Files (Optional) 
You will have the greatest control over the appearance of 

your figures if you are able to prepare electronic image files. 
If you do not have the required computer skills, just submit 
paper prints as described above and skip this section. 

1) Easiest Way: If you have a scanner, the best and quickest 
way to prepare noncolor figure files is to print your tables and 
figures on paper exactly as you want them to appear, scan 
them, and then save them to a file in PostScript (PS) or 
Encapsulated PostScript (EPS) formats. Use a separate file for 
each image. File names should be of the form “fig1.ps” or 
“fig2.eps.” 

2) Slightly Harder Way: Using a scanner as above, save the 
images in TIFF format. High-contrast line figures and tables 
should be prepared with 600 dpi resolution and saved with no 
compression, 1 bit per pixel (monochrome), with file names of 
the form “fig3.tif” or “table1.tif.” To obtain a 3.45-in figure 
(one-column width) at 600 dpi, the figure requires a horizontal 
size of 2070 pixels. Typical file sizes will be on the order of 
0.5 MB. 

Photographs and grayscale figures should be prepared with 
220 dpi resolution and saved with no compression, 8 bits per 
pixel (grayscale). To obtain a 3.45-in figure (one-column 
width) at 220 dpi, the figure should have a horizontal size of 

759 pixels.  
Color figures should be prepared with 400 dpi resolution 

and saved with no compression, 8 bits per pixel (palette or 
256 color). To obtain a 3.45-in figure (one column width) at 
400 dpi, the figure should have a horizontal size of 1380 
pixels.  

For more information on TIFF files, please go to 
http://www.ieee.org/organizations/pubs/transactions/informati
on.htm and click on the link “Guidelines for Author Supplied 
Electronic Text and Graphics.” 

3) Somewhat Harder Way: If you do not have a scanner, 
you may create noncolor PostScript figures by “printing” them 
to files. First, download a PostScript printer driver from 
http://www.adobe.com/support/downloads/pdrvwin.htm (for 
Windows) or from http://www.adobe.com/support/downloads/ 
pdrvmac.htm (for Macintosh) and install the “Generic 
PostScript Printer” definition. In Word, paste your figure into 
a new document. Print to a file using the PostScript printer 
driver. File names should be of the form “fig5.ps.” Use Adobe 
Type 1 fonts when creating your figures, if possible.  

4) Other Ways: Experienced computer users can convert 
figures and tables from their original format to TIFF. Some 
useful image converters are Adobe Photoshop, Corel Draw, 
and Microsoft Photo Editor, an application that is part of 
Microsoft Office 97 and Office 2000 (look for C:\Program 
Files\Common Files \Microsoft Shared\ PhotoEd\ 
PHOTOED.EXE. (You may have to custom-install Photo 
Editor from your original Office disk.) 

Here is a way to make TIFF image files of tables. First, 
create your table in Word. Use horizontal lines but no vertical 
lines. Hide gridlines (Table | Hide Gridlines). Spell check the 
table to remove any red underlines that indicate spelling 
errors. Adjust magnification (View | Zoom) such that you can 
view the entire table at maximum area when you select View | 
Full Screen. Move the cursor so that it is out of the way. Press 
“Print Screen” on your keyboard; this copies the screen image 
to the Windows clipboard. Open Microsoft Photo Editor and 
click Edit | Paste as New Image. Crop the table image (click 
Select button; select the part you want, then Image | Crop). 
Adjust the properties of the image (File | Properties) to 
monochrome (1 bit) and 600 pixels per inch. Resize the image 
(Image | Resize) to a width of 3.45 inches. Save the file (File | 
Save As) in TIFF with no compression (click “More” button).  

Most graphing programs allow you to save graphs in TIFF; 
however, you often have no control over compression or 
number of bits per pixel. You should open these image files in 
a program such as Microsoft Photo Editor and re-save them 
using no compression, either 1 or 8 bits, and either 600 or 220 
dpi resolution (File | Properties; Image | Resize). See Section 
II-D2 for an explanation of number of bits and resolution. If 
your graphing program cannot export to TIFF, you can use the 
same technique described for tables in the previous paragraph. 

A way to convert a figure from Windows Metafile (WMF) 
to TIFF is to paste it into Microsoft PowerPoint, save it in 
JPG format, open it with Microsoft Photo Editor or similar 
converter, and re-save it as TIFF. 
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Microsoft Excel allows you to save spreadsheet charts in 
Graphics Interchange Format (GIF). To get good resolution, 
make the Excel charts very large. Then use the “Save as  

 
HTML” feature (see http://support.microsoft.com/support/ 
kb/articles/q158/0/79.asp). You can then convert from GIF to 
TIFF using Microsoft Photo Editor, for example. 

No matter how you convert your images, it is a good idea to 
print the TIFF files to make sure nothing was lost in the 
conversion.  

If you modify this document for use with other IEEE 
journals or conferences, you should save it as type “Word 97-
2000 & 6.0/95 - RTF (*.doc)” so that it can be opened by any 
version of Word. 

E. Copyright Form 
An IEEE copyright form should accompany your final 

submission. You can get a .pdf, .html, or .doc version at 
http://www.ieee.org/copyright or from the first issues in each 
volume of the IEEE TRANSACTIONS and JOURNALS. Authors 
are responsible for obtaining any security clearances. 

 

III. MATH 
If you are using Word, use either the Microsoft Equation 

Editor or the MathType add-on (http://www.mathtype.com) 
for equations in your paper (Insert | Object | Create New | 
Microsoft Equation or MathType Equation). “Float over text” 
should not be selected.  

 

IV. UNITS 
Use either SI (MKS) or CGS as primary units. (SI units are 

strongly encouraged.) English units may be used as secondary 
units (in parentheses). This applies to papers in data 
storage. For example, write “15 Gb/cm2 (100 Gb/in2).” An 

exception is when English units are used as identifiers in 
trade, such as “3½ in disk drive.” Avoid combining SI and 
CGS units, such as current in amperes and magnetic field in 
oersteds. This often leads to confusion because equations do 
not balance dimensionally. If you must use mixed units, 
clearly state the units for each quantity in an equation. 

The SI unit for magnetic field strength H is A/m. However, 
if you wish to use units of T, either refer to magnetic flux 
density B or magnetic field strength symbolized as µ0H. Use 
the center dot to separate compound units, e.g., “A·m2.” 

 

V. HELPFUL HINTS 

A. Figures and Tables 
Because IEEE will do the final formatting of your paper, 

you do not need to position figures and tables at the top and 
bottom of each column. In fact, all figures, figure captions, 
and tables can be at the end of the paper. Large figures and 
tables may span both columns. Place figure captions below the 
figures; place table titles above the tables. If your figure has 
two parts, include the labels “(a)” and “(b)” as part of the 
artwork. Please verify that the figures and tables you mention 
in the text actually exist. Please do not include captions as 
part of the figures. Do not put captions in “text boxes” 
linked to the figures. Do not put borders around the 
outside of your figures. Use the abbreviation “Fig.” even at 
the beginning of a sentence. Do not abbreviate “Table.” 
Tables are numbered with Roman numerals.  

Color printing of figures is available, but is billed to the 

TABLE I 
UNITS FOR MAGNETIC PROPERTIES 

Symbol Quantity Conversion from Gaussian and 
CGS EMU to SI a 

Φ magnetic flux 1 Mx → 10−8 Wb = 10−8 V·s 
B magnetic flux density,  

  magnetic induction 
1 G → 10−4 T = 10−4 Wb/m2 

H magnetic field strength 1 Oe → 103/(4π) A/m 
m magnetic moment 1 erg/G = 1 emu  

  → 10−3 A·m2 = 10−3 J/T 
M magnetization 1 erg/(G·cm3) = 1 emu/cm3 

  → 103 A/m 
4πM magnetization 1 G → 103/(4π) A/m 
σ specific magnetization 1 erg/(G·g) = 1 emu/g → 1 A·m2/kg 
j magnetic dipole  

  moment 
1 erg/G = 1 emu  
  → 4π × 10−10 Wb·m 

J magnetic polarization 1 erg/(G·cm3) = 1 emu/cm3 
  → 4π × 10−4 T 

χ, κ susceptibility 1 → 4π 
χρ mass susceptibility 1 cm3/g → 4π × 10−3 m3/kg 
µ permeability 1 → 4π × 10−7 H/m  

  = 4π × 10−7 Wb/(A·m) 
µr relative permeability µ → µr 
w, W energy density 1 erg/cm3 → 10−1 J/m3 

N, D demagnetizing factor 1 → 1/(4π) 

No vertical lines in table. Statements that serve as captions for the entire 
table do not need footnote letters.  

aGaussian units are the same as cgs emu for magnetostatics; Mx = 
maxwell, G = gauss, Oe = oersted; Wb = weber, V = volt, s = second, T = 
tesla, m = meter, A = ampere, J = joule, kg = kilogram, H = henry. 

 

Fig. 1.  Magnetization as a function of applied field. Note that “Fig.” is 
abbreviated. There is a period after the figure number, followed by two
spaces. It is good practice to explain the significance of the figure in the
caption. 



> REPLACE THIS LINE WITH YOUR PAPER IDENTIFICATION NUMBER (DOUBLE-CLICK HERE TO EDIT) < 
 

4

authors (approximately $1300, depending on the number of 
figures and number of pages containing color). Include a note 
with your final paper indicating that you request color 
printing. Do not use color unless it is necessary for the 
proper interpretation of your figures. If you want reprints 
of your color article, the reprint order should be submitted 
promptly. There is an additional charge of $81 per 100 for 
color reprints. 

Figure axis labels are often a source of confusion. Use 
words rather than symbols. As an example, write the quantity 
“Magnetization,” or “Magnetization M,” not just “M.” Put 
units in parentheses. Do not label axes only with units. As in 
Fig. 1, for example, write “Magnetization (A/m)” or 
“Magnetization (A ⋅ m−1),” not just “A/m.” Do not label axes 
with a ratio of quantities and units. For example, write 
“Temperature (K),” not “Temperature/K.”  

Multipliers can be especially confusing. Write 
“Magnetization (kA/m)” or “Magnetization (103 A/m).” Do 
not write “Magnetization (A/m) × 1000” because the reader 
would not know whether the top axis label in Fig. 1 meant 
16000 A/m or 0.016 A/m. Figure labels should be legible, 
approximately 8 to 12 point type. 

B. References 
Number citations consecutively in square brackets [1]. The 

sentence punctuation follows the brackets [2]. Multiple 
references [2], [3] are each numbered with separate brackets 
[1]–[3]. When citing a section in a book, please give the 
relevant page numbers [2]. In sentences, refer simply to the 
reference number, as in [3]. Do not use “Ref. [3]” or 
“reference [3]” except at the beginning of a sentence: 
“Reference [3] shows ... .” Unfortunately the IEEE document 
translator cannot handle automatic endnotes in Word; 
therefore, type the reference list at the end of the paper using 
the “References” style. 

Number footnotes separately in superscripts (Insert | 
Footnote).1 Place the actual footnote at the bottom of the 
column in which it is cited; do not put footnotes in the 
reference list (endnotes). Use letters for table footnotes (see 
Table I).  

Please note that the references at the end of this document 
are in the preferred referencing style. Give all authors’ names; 
do not use “et al.” unless there are six authors or more. Use a 
space after authors' initials. Papers that have not been 
published should be cited as “unpublished” [4]. Papers that 
have been submitted for publication should be cited as 
“submitted for publication” [5]. Papers that have been 
accepted for publication, but not yet specified for an issue 
should be cited as “to be published” [6]. Please give 
affiliations and addresses for private communications [7]. 

Capitalize only the first word in a paper title, except for 
proper nouns and element symbols. For papers published in 
translation journals, please give the English citation first, 
 

1It is recommended that footnotes be avoided (except for the unnumbered 
footnote with the receipt date on the first page). Instead, try to integrate the 
footnote information into the text. 

followed by the original foreign-language citation [8]. 

C. Abbreviations and Acronyms 
Define abbreviations and acronyms the first time they are 

used in the text, even after they have already been defined in 
the abstract. Abbreviations such as IEEE, SI, ac, and dc do not 
have to be defined. Abbreviations that incorporate periods 
should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” 
Do not use abbreviations in the title unless they are 
unavoidable (for example, “IEEE” in the title of this article). 

D. Equations 
Number equations consecutively with equation numbers in 

parentheses flush with the right margin, as in (1). First use the 
equation editor to create the equation. Then select the 
“Equation” markup style. Press the tab key and write the 
equation number in parentheses. To make your equations 
more compact, you may use the solidus ( / ), the exp function, 
or appropriate exponents. Use parentheses to avoid 
ambiguities in denominators. Punctuate equations when they 
are part of a sentence, as in 
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Be sure that the symbols in your equation have been 

defined before the equation appears or immediately following. 
Italicize symbols (T might refer to temperature, but T is the 
unit tesla). Refer to “(1),” not “Eq. (1)” or “equation (1),” 
except at the beginning of a sentence: “Equation (1) is ... .” 

E. Other Recommendations 
Use one space after periods and colons. Hyphenate complex 

modifiers: “zero-field-cooled magnetization.” Avoid dangling 
participles, such as, “Using (1), the potential was calculated.” 
[It is not clear who or what used (1).] Write instead, “The 
potential was calculated by using (1),” or “Using (1), we 
calculated the potential.” 

Use a zero before decimal points: “0.25,” not “.25.” Use 
“cm3,” not “cc.” Indicate sample dimensions as “0.1 cm × 0.2 
cm,” not “0.1 × 0.2 cm2.” The abbreviation for “seconds” is 
“s,” not “sec.” Do not mix complete spellings and 
abbreviations of units: use “Wb/m2” or “webers per square 
meter,” not “webers/m2.” When expressing a range of values, 
write “7 to 9” or “7-9,” not “7~9.” 

A parenthetical statement at the end of a sentence is 
punctuated outside of the closing parenthesis (like this). (A 
parenthetical sentence is punctuated within the parentheses.) 
In American English, periods and commas are within 
quotation marks, like “this period.” Other punctuation is 
“outside”! Avoid contractions; for example, write “do not” 
instead of “don’t.” The serial comma is preferred: “A, B, and 
C” instead of “A, B and C.” 

If you wish, you may write in the first person singular or 
plural and use the active voice (“I observed that ...” or “We 
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observed that ...” instead of “It was observed that ...”). 
Remember to check spelling. If your native language is not 
English, please get a native English-speaking colleague to 
proofread your paper.  

 

VI. SOME COMMON MISTAKES 
The word “data” is plural, not singular. The subscript for 

the permeability of vacuum µ0 is zero, not a lowercase letter 
“o.” The term for residual magnetization is “remanence”; the 
adjective is “remanent”; do not write “remnance” or 
“remnant.” Use the word “micrometer” instead of “micron.” A 
graph within a graph is an “inset,” not an “insert.” The word 
“alternatively” is preferred to the word “alternately” (unless 
you really mean something that alternates). Use the word 
“whereas” instead of “while” (unless you are referring to 
simultaneous events). Do not use the word “essentially” to 
mean “approximately” or “effectively.” Do not use the word 
“issue” as a euphemism for “problem.” When compositions 
are not specified, separate chemical symbols by en-dashes; for 
example, “NiMn” indicates the intermetallic compound 
Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some 
composition NixMn1-x. 

Be aware of the different meanings of the homophones 
“affect” (usually a verb) and “effect” (usually a noun), 
“complement” and “compliment,” “discreet” and “discrete,” 
“principal” (e.g., “principal investigator”) and “principle” 
(e.g., “principle of measurement”). Do not confuse “imply” 
and “infer.”  

Prefixes such as “non,” “sub,” “micro,” “multi,” and 
“"ultra” are not independent words; they should be joined to 
the words they modify, usually without a hyphen. There is no 
period after the “et” in the Latin abbreviation “et al.” (it is also 
italicized). The abbreviation “i.e.,” means “that is,” and the 
abbreviation “e.g.,” means “for example” (these abbreviations 
are not italicized). 

An excellent style manual and source of information for 
science writers is [9]. A general IEEE style guide, Information 
for Authors, is available at 
http://www.ieee.org/organizations/pubs/transactions/informati
on.htm 
 

VII. EDITORIAL POLICY 
Submission of a manuscript is not required for participation 

in a conference. Do not submit a reworked version of a paper 
you have submitted or published elsewhere. Do not publish 
“preliminary” data or results. The submitting author is 
responsible for obtaining agreement of all coauthors and any 
consent required from sponsors before submitting a paper. 
IEEE TRANSACTIONS and JOURNALS strongly discourage 
courtesy authorship. It is the obligation of the authors to cite 
relevant prior work. 

The Transactions and Journals Department does not publish 
conference records or proceedings. The TRANSACTIONS does 

publish papers related to conferences that have been 
recommended for publication on the basis of peer review. As 
a matter of convenience and service to the technical 
community, these topical papers are collected and published in 
one issue of the TRANSACTIONS. 

At least two reviews are required for every paper submitted. 
For conference-related papers, the decision to accept or reject 
a paper is made by the conference editors and publications 
committee; the recommendations of the referees are advisory 
only. Undecipherable English is a valid reason for rejection. 
Authors of rejected papers may revise and resubmit them to 
the TRANSACTIONS as regular papers, whereupon they will be 
reviewed by two new referees. 

 

VIII. PUBLICATION PRINCIPLES 
The contents of IEEE TRANSACTIONS and JOURNALS are 

peer-reviewed and archival. The TRANSACTIONS publishes 
scholarly articles of archival value as well as tutorial 
expositions and critical reviews of classical subjects and 
topics of current interest.  

Authors should consider the following points: 
1) Technical papers submitted for publication must advance 

the state of knowledge and must cite relevant prior work.  
2) The length of a submitted paper should be commensurate 

with the importance, or appropriate to the complexity, of 
the work. For example, an obvious extension of 
previously published work might not be appropriate for 
publication or might be adequately treated in just a few 
pages. 

3) Authors must convince both peer reviewers and the 
editors of the scientific and technical merit of a paper; the 
standards of proof are higher when extraordinary or 
unexpected results are reported.  

4) Because replication is required for scientific progress, 
papers submitted for publication must provide sufficient 
information to allow readers to perform similar 
experiments or calculations and use the reported results. 
Although not everything need be disclosed, a paper must 
contain new, useable, and fully described information. 
For example, a specimen's chemical composition need not 
be reported if the main purpose of a paper is to introduce 
a new measurement technique. Authors should expect to 
be challenged by reviewers if the results are not supported 
by adequate data and critical details. 

5) Papers that describe ongoing work or announce the latest 
technical achievement, which are suitable for presentation 
at a professional conference, may not be appropriate for 
publication in a TRANSACTIONS or JOURNAL. 

 

IX. CONCLUSION 
A conclusion section is not required. Although a conclusion 

may review the main points of the paper, do not replicate the 
abstract as the conclusion. A conclusion might elaborate on 
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the importance of the work or suggest applications and 
extensions.  

APPENDIX 
Appendixes, if needed, appear before the acknowledgment. 

ACKNOWLEDGMENT 
The preferred spelling of the word “acknowledgment” in 

American English is without an “e” after the “g.” Use the 
singular heading even if you have many acknowledgments. 
Avoid expressions such as “One of us (S.B.A.) would like to 
thank ... .” Instead, write “F. A. Author thanks ... .” Sponsor 
and financial support acknowledgments are placed in the 
unnumbered footnote on the first page. 
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